3D Modeling with the Best, AutoCAD!

Vince Sheehan
Sr. Civil Designer

Learning Objectives

- Learn how to create 3D Solid, Surface, and Mesh objects using various tools.
- Learn how to edit the objects using tools such as Union, Slice, Extrude Face, Fillet, and so on.
- Learn how to apply texturing and materials to 3D objects.
- Learn how to export the 3D objects to various formats.

Description

In this lab, you’ll learn how to create 3D geometry using AutoCAD solid, surface, and mesh tools. Create 3D assets for Revit families, Civil 3D and InfraWorks models, Inventor software, game engines, and other software environments. Edit the 3D objects using various editing tools, such as Union, Slice, Extrude Face, Fillet, and so on. Export the 3D objects. This class is designed to expand your AutoCAD 3D modeling knowledge.

Speaker(s)

Vince has been using Autodesk products since 1992. He has been working in the GIS, Civil Engineering and Surveying field since 1995. He currently serves as Sr. Designer for a civil engineering consulting firm located in Richmond, Virginia. He is also a Design Specialist and Blogger on the site Poly In 3D where he writes tutorials and how to tips for Autodesk products. Vince has also been 3D modeling and rendering for over 15 years using a verity of Autodesk® products and other non-Autodesk® products. Autodesk University 2012 lab speaker on Civil 3D 2013, Civil View 2013 and 3ds Max Design 2013. Autodesk University 2015 lab speaker on Vehicle Tracking 2016, Autodesk University 2017 on Autodesk Stingray and Autodesk University 2019 on 3D modeling with AutoCAD.

vsheehan@comcast.net
Poly In 3D Blog
Vincent Sheehan (@vlsheehan) | Twitter
Vince Sheehan | Linked in
Launch AutoCAD 2021

3D Modeling Workspace
Set the workspace to “3D Modeling”. This will have all the necessary tools to create 3D assets and 3D environments.

3D Modeling Ribbon Menus
Below are the 3D modeling types used in this exercise. 3D Solid, 3D Surface, 3D Mesh and 3D Face.

Solid Tab:

3D Solid objects consist of primitive shapes and extruded profile. Solids contain volume/mass properties.

Surface Tab:

3D Surface creation tools are similar to the 3D Solid tools such as sweeping, lofting, extruding, and revolving. 3D Surfaces can also be created by blending, patching, offsetting, filleting, and extending other surfaces. They do not contain volume/mass properties.

Mesh Tab:

3D Mesh is similar to 3D Surfaces. They contain vertices, edges, and faces that use polygonal representation. They also do not contain volume/mass properties.
Coordinates/UCS, Commands, Views, Visual Styles and Draw/System Variables

**Adjusting the UCS:**
Click the Home Tab, Coordinates panel.
Default UCS is World coordinates. Adjust the Z-Axis by click the Z button. Select and object face or object intersection the drag the mouse in the direction to establish the Z-Axis.

**Dynamic UCS:**
Located in the Status bar. When creating an object, Dynamic UCS temporarily aligns the XY plane of the UCS to a planar face on objects such as 3D solids and planar mesh elements.

**Views:**
Click the Home tab, View panel or click View Controls on the upper left of the workspace.

- SW Isometric
- 2D Wireframe

(The command to turn on the Viewport Controls is VPCONTROL.)

**Visual Styles:**
Click the View tab, Palettes panel or click Visual Style Controls on the upper left of the workspace.

- SW Isometric
- 2D Wireframe

**3D Osnap:**
Snaps the cursor to 3D solids, surfaces, and point cloud segments.

**Facetres (System Variable):**
Facetres adjust the smoothness of rendered objects and shadows.
Initial value: 0.5000
Valid values are from 0.01 to 10.0.

**Viewres (Command):**
Controls the sharpness of circles, arcs, splines, and arced polylines using short vectors.

**Surftab1 & 2 (System Variables):**
Sets the mesh density in the M and N direction for the REVSURF and EDGESURF commands.

**3D Orbit:**
Rotate/Orbit the view in the current viewport. Drag the cursor horizontally, the camera moves parallel to the XY plane. Drag the cursor vertically, the camera moves along the Z axis.

**3D Rotate:**
Rotate an object along the X, Y, Z axis using the Rotate Gizmo.

**3D Scale:**
Scale an object as a whole or along the X, Y, Z axis using the Scale Gizmo.

**3D Move:**
Move an object along the X, Y, Z axis using the Move Gizmo.
Creating Primitive Objects

Primitive objects are basic 3D shapes made of solid or mesh objects.

1. **Solid Primitive Objects.** Solid tab, Primitive panel.
   a. Box
   b. Cylinder
   c. Sphere
   d. Polysolid
   e. Wedge
   f. Cone
   g. Pyramid
   h. Torus
   i. Show History (Records the history of the solid objects).

2. **Mesh Primitive Objects.** Mesh tab, Primitive panel.
   a. Mesh Box
   b. Mesh Cone
   c. Mesh Cylinder
   d. Mesh Pyramid
   e. Mesh Sphere
   f. Mesh Wedge
   g. Mesh Torus
   h. REVSURF (Revolve Surface)
   i. EDGESURF (Edge Surface)
   j. RULESURF (Ruled Surface)
   k. TABSURF (Tabulated Surface)

3. **Drawing Objects.** Home tab, Draw panel.
   a. Line
   b. Polyline
   c. 3D Polyline
   d. Spline
   e. Helix
   f. Circle
   g. Polygon
   h. Rectabgle
   i. Ellipse
   j. Region
   k. 3DFace
Creating Solid Objects
1. Solid objects can be created by several different methods.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Solid Shapes-01.dwg”.
   b. Click Solid tab, Solid panel.
   c. Click Extrude. Select the yellow shapes. Specify height of extrusion of 5 then press Enter.
   d. Click Presspull. Select a face on the blue Solid object then move the mouse to either side.
   e. Click Revolve. Select the red half lamp shape objects. Snap Endpoint to the bottom left #1 then upper left #2. Type 360 then press Enter.
   f. Click Sweep. Select the cyan circle. Click Alignment in the command line then select the cyan polyline.
   g. Click Loft (below Sweep). Select the series of magenta circles then press Enter twice..
   h. Click Thicken. Select the green surface object. Type the specified thickness of 5 then press Enter.

Creating Surface Objects
1. Surface objects can be created by several different methods.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Surface Shapes-01.dwg”.
   b. Click Surface tab, Create panel.
   c. Click Network. Select the red polylines 1, 2, & 3 then press Enter. Select polylines 4 & 5 then press Enter.
   d. Click Loft. Select the series of magenta circles then press Enter twice.
   e. Click Sweep. Select the cyan circle. Click Alignment in the command line then select the cyan polyline.
   f. Click Planar. Select the green polygon.
   g. Click Extrude then select the yellow polygons. Specify height of extrusion of 5 then Enter.
   h. Click Revolve. Select the red half lamp shape objects. Snap Endpoint to the bottom left #1 then upper left #2. Type 360 then press Enter.
   i. Click Blend. Select the green surface circle edge #1 then press Enter. Select the green surface circle edge #2 then press Enter. Click the List Icon then select G0, G1 or G2.
   j. Click Patch. Select the top edge of a blue shape then press Enter. Select the List Icon then select G0, G1 or G2 to change it’s shape.
   k. Click Offset. Select the top edge of an orange shape. Type 0.5 then press Enter.
   l. Click Trim

Creating Mesh Objects
1. Mesh objects can be created by several different methods.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Mesh Shapes-01.dwg”.
   b. Click EDGESURF. Select the yellow polylines 1, 2, 3 & 4.
   c. Click REVSURF. Select the green polyline then select the yellow polylines axis then press Enter for angle and Enter to revolve the object 360 degrees.
   d. Repeat step C for the other parts of the lamp.
   e. Click RULESURF. Select the red polyline then the yellow polyline.
   f. Repeat step E then select the red polyline and green polylines.
   g. Click TABSURF. Select the green polyline then the yellow polyline.
Editing 3D Objects

1. Editing 3D Solid objects can be achieved by several different methods.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Solid Shapes-01.dwg”.
   b. Click the Solid Tab on the Ribbon.

Union
   a. Click the Union button on the Boolean panel.
   b. Select the two red spheres to join together.

Subtract
   a. Click the Subtract button on the Boolean panel.
   b. Select the two yellow spheres to subtract one object from another.

Intersect
   a. Click the Intersect button on the Boolean panel.
   b. Select the two cyan spheres to join the objects where they intersect.

Fillet Edge
   a. Click Fillet Edge button on the Solid Editing panel.
   b. Select an edge marked #1 on the red cube.

Chamfer Edge
   a. Click the Chamfer Edge button under the Fillet Edge button on the Solid Editing panel.
   b. Select an edge marked #1 on the yellow cube.

Taper Face
   a. Click Taper Face button on the Solid Editing panel.
   b. Select the face marked #1 on the green cube.
   c. Snap endpoint to #2 then #3.
   d. Type 15 to taper the face 15 degrees.

Extrude Faces
   a. Click Extrude Faces button on the Solid Editing panel.
   b. Select a face marked #1 on the cyan cube, type a distance of 1 then press Enter.

Offset Faces
   a. Click Offset Faces button on the Solid Editing panel.
   b. Select a face marked #1 on the blue cube, type a distance of 1 then press Enter.

Shell
   a. Click Shell button on the Solid Editing panel.
   b. Select the magenta cube, type a distance of 0.5 then press Enter.

2. Editing 3D Surface objects can be achieved by several different methods.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Surface Shapes-01.dwg”.
   b. Click the Surface Tab on the Ribbon.

Fillet
   a. Click the Fillet button on the Edit panel.
   b. Select a blue surface then select the green surface.
   c. Click the Radius in the command line, type 0.5 then press Enter.

Trim
   a. Click the Trim button on the Edit panel.
   b. Select the green surface then press Enter.
   c. Select the blue circle then press Enter.
   d. Click inside the circle then press Enter. The Untrim command will untrim the area.
3D Mail Drop Box

1. Constructing a 3D drop box with solids.
   
a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Dropbox.dwg”. (Outlines of the drop box are already in the drawing on the layer “GUIDELINES”.)
   
b. Set DROPBOX layer current.
   
c. Click the Extrude button on the Solid tab, Solid panel.
   
d. Click Mode in the command line.
   
e. Click Solid.
   
f. Select the cyan color leg/frame.
   
g. Click Path in the command line then select the magenta polyline.
   
h. Repeat Extrude.
   
i. Select the blue square.
   
j. Drag the solid up then Snap Endpoint to the bottom corner of the green polyline.
   
k. Repeat Extrude.
   
l. Select the white rectangle.
   
m. Drag the solid outwards then Snap Endpoint to the bottom corner of the green polyline.
   
n. Repeat Extrude.
   
o. Select the green polyline.
   
p. Drag the solid across the main box then Snap Endpoint to the corner of the solid.
   
q. Click the Solid, Subtract button under the Home tab, Solid Editing panel. (This will subtract 3D solids from another.)
   
r. Select the solid created in steps p & q then then press Enter.
   
s. Select the solid created in steps m & n then press Enter.
   
t. Click the Solid, Union button under the Home tab, Solid Editing panel.
   
u. Select the lower and upper half of the drop box. (This will combine multiple 3D solids into a single 3D solid.)
   
v. Mirror the leg/frame solid to the opposite side.


   a. Refer to page 15 for importing, assigning textures and materials.
   
b. Click the Material Browser button from the Visualize tab, Materials panel or type materials from the command line.
   
c. Two materials for the drop box are save in the drawing. (Dropbox_Color and Dropbox_Logo)
   
d. Select the three 3D solids that makeup the drop box.
   
e. Right click on the Dropbox_Color materials then click Assign to Selection.
   
f. Click Dropbox_Logo then drag it while holding the Control (ctrl) key to the side of the drop box.
   
g. Repeat step f for the opposite side of the drop box.
   
h. Adjust the material mapping by clicking the Material Mapping button from the Visualize tab, Materials panel then while holding the Control (ctrl) key, pick the side of the drop box.
**3D Canopy**

1. **Constructing a 3D canopy with Surfaces.**

   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Canopy.dwg”. (Outlines of the canopy are already in the drawing on the layer “GUIDELINES”)
   
   b. Set “CANOPY - COVER” layer current.
   
   c. Click the **Network** button under the Surface tab, Create panel.
   
   d. Select the top yellow polylines then press **Enter**.
   
   e. Select the top red polylines then press **Enter**.
   
   f. Click the **Loft** button under the Surface tab, Create panel.
   
   g. Select the lower green and the yellow polylines then press **Enter**.
   
   h. Repeat step “e” for the left and right side and the back.
   
   i. Set “CANOPY - POST” layer current.
   
   j. Click the **Sweep** button under the Surface tab, Create panel.
   
   k. Select the green circle then press **Enter**.
   
   l. Click **Alignment** in the command line.
   
   m. Click **Yes** to align sweep object perpendicular to path before sweep.
   
   n. Select the cyan polyline.
   
   o. Set “CANOPY - SHELF” layer current.
   
   p. Click the **Extrude** button under the Surface tab, Create panel.
   
   q. Select the brown shelf support polyline then press **Enter** then type 0.1 for an extrusion height.
   
   r. Repeat steps “n – o” for the rest of the shelf supports.
   
   s. Click the **Extrude** button under the Surface tab, Create panel.
   
   t. Select all the white rectangle polylines then press **Enter** then type 8.2 for an extrusion height.

2. Apply a materials to the objects. (Directions shown on page 15)
3D Car Wheel

1. Constructing the 3D wheel.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Car Wheel.dwg”. (Outlines of the wheel are already in the drawing on the layer “GUIDELINES”.)
   b. Click the Solid Tab on the Ribbon.
   c. Set layer 3DWHEEL current.
   d. Click the Revolve button on the Solid panel.
   e. Click Mode in the command line then select Solid.
   f. Select the two green polygons then press Enter.
   g. Specify Axis Start Point. Snap Endpoint to one end of the red centerline then Snap Endpoint to the other end of the red centerline.
   h. Type 360 at the command line then press Enter.

2. Constructing the lug bolt holes.
   a. Set layer 3DWHEEL-HOLES current.
   b. Click the Revolve button on the Solid panel.
   c. Click Mode in the command line then select Solid.
   d. Select the blue polygon then press Enter.
   e. Specify Axis Start Point. Snap Endpoint to one end of the yellow centerline then Snap Endpoint to the other end of the yellow centerline.
   f. Type 360 at the command line then press Enter.
   g. Array the newly created cylinder by typing 3DArray at the command line then press Enter.
   h. Select the newly created cylinder.
   i. Click Polar in the command line then press Enter.
   j. Click Axis of rotation in the command then press Enter.
   k. Snap Endpoint to one end of the red centerline then Snap Endpoint to the other end of the red centerline.
   l. Click Items in the command, type 5 then press Enter twice.
   m. Click the Solid Tab on the Ribbon.
   n. Click the Subtract button on the Boolean panel.
   o. Select the newly created cylinder then press Enter.
   p. Select the center section of the wheel then press Enter.
3. Constructing the 3D wheel spokes.

   a. Set layer 3DWHEEL SPOKES current.
   b. Click the Solid Tab on the Ribbon.
   c. Click the Loft button on the Solids panel. (Located below the Sweep button.)
   d. Select the two white rectangles then press Enter.
   e. Click Path in the command line, select the cyan polyline then press Enter.
   f. Array the newly created cylinder by typing 3DArray at the command line then press Enter.
   g. Select the newly created cylinder.
   h. Click Polar in the command line then press Enter.
   i. Click Axis of rotation in the command then press Enter.
   j. Snap Endpoint to one end of the red centerline then Snap Endpoint to the other end of the red centerline.
   k. Click Items in the command, type 5 then press Enter twice.
   l. Apply a materials to the objects. (Directions shown on page 15)
**3D Pulley**

1. **Construct the 3D pulley with the tools solid learned in this handout.**
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Pulley.dwg. (Outlines of the pulley are already in the drawing on the layer "GUIDELINES").
   b. Set Pulley layer current.
   c. **Extrude** the blue close polygon a length of 2.0 then press **Enter**.
   d. **Extrude** the green closed polygons 0.10 then press **Enter**.
   e. **Extrude** the cyan closed polygons 0.05 then press **Enter**.
   f. Array the newly created solid objects by typing **3DArray** at the command line then press **Enter**.
   g. Select the newly created solid objects.
   h. Click **Polar** in the command line then press **Enter**.
   i. Click **Axis** of rotation in the command then press **Enter**.
   j. Snap Endpoint to one end of the red centerline then Snap Endpoint to the other end of the red centerline.
   k. Click **Items** in the command, type 5 then press **Enter** twice
   l. **Revolve** the closed magenta polyline 360° around the red centerline.
   m. **Subtract** the solids created from the blue polyline from the main pulley.
   n. **Union** the solids created from the green polygons to the main pulley.
   o. **Subtract** the solid created from the cyan polygon from the main pulley.
   p. Apply a materials to the objects. (Directions shown on page 15)
3D Table and Tablecloth

1. Construct the 3D pulley with the solid and surface tools learned in this handout.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Table.dwg. (Outlines of the tablecloth are already in the drawing on the layer “GUIDELINES”.)
   b. Set Table layer current.
   c. Extrude the green closed polygons using the cyan polylines as a path to create a table leg.
   d. 3DArray the table leg around 0,0. 4 or 5 legs will look ok.
   e. Extrude the magenta circles 0.333 to create the table top.
   f. Subtract the inter solid from the outer solid.
   g. Extrude the red circle 0.0833 then press Enter.
   h. Fillet the top edge of the tabletop 0.05 then press Enter.
   i. Set Tablecloth layer current.
   j. Loft using the lower blue spline and the top blue circle to create the table cloth.
   k. Patch the top of the tablecloth using the top blue circle to create the table cloth.
   l. Apply a material to the objects. (Directions shown on page 15)
**3D Street Light**

1. **Construct the 3D street light with the tools solid learned in this handout.**

   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Light_Pole.dwg”.
   b. (Outlines of the light pole are already in the drawing on the layer “GUIDELINES”.)
   c. Set the LIGHTPOLE-BASE layer current.
   d. Click the **Loft** button on the Solids panel. (Located below the Sweep button.)
   e. Select each magenta closed polylines starting at the bottom to create the base.
   f. Set the LIGHTPOLE-POLE layer current.
   g. Click the **Extrude** button on the Solids panel.
   h. Select the red circle then press **Enter**.
   i. Click **Path** in the command line, select the cyan polyline then press **Enter**.
   j. Set the LIGHTPOLE-HOUSING layer current.
   k. Click the **Extrude** button on the Solids panel.
   l. Select the outer green rectangle then press **Enter**.
   m. Type a height of 5.0 then press **Enter**.
   n. Click the **Extrude** button on the Solids panel.
   o. Select the inner green rectangle then press **Enter**.
   p. Type a height of 4.5 then press **Enter**.
   q. Layer isolate the LIGHTPOLE-HOUSING layer.
   r. **Solid Subtract** the inner solid from the outer solid.
   s. Turn all layers on.
   t. Set the LIGHTPOLE-LENS layer current.
   u. Click the **Extrude** button on the Solids panel.
   v. Select the yellow rectangle then press **Enter**.
   w. Type a height of 0.4 then press **Enter**.
   x. Apply a materials to the objects. (Directions shown on page 15)
3D Tennis Court

1. Complete the building frame with the tools learned in this handout.
   a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD\DWG\Tennis Court.dwg”.
   b. Create 3D objects from the linework on layer GUIDELINES. Use the mirrored side of the stadium as a reference. Use tools such as Extruding, Revolving, Sweeping, Lofting and so on.
Assigning Textures and Materials.

a. Open “C:\DATASETS\AS463689-L - 3D Modeling with the Best, AutoCAD-DWG\Dropbox.dwg”.
b. Isolate layer “DROPBOX”.
c. Click the Material Browser button under the Visualize tab, Materials panel.
d. Click the Create New Material button then select New Generic Material. (The Materials Editor will open)
e. Rename the material name to “Dropbox_Color”.
f. Click the white image box then select Dropbox_Color.png from the “IMG” folder.
g. Close the Texture Editor and Materials Editor.
h. Set the Visual Style to “Realistic” to see the materials.
i. To adjust the material mapping, click the Material Mapping button under the Visualize tab, Materials panel then while holding the “Control” (ctrl) key, pick the side of the drop box.
j. Repeat for additional materials.
Additional Resources:

Pre-made assets can also be found in the AutoCAD Civil 3D or AutoCAD Architecture install as Multiview Blocks.

`c:\Users\All Users\Autodesk\C3D 2021\enu\Data\Symbols\Mvblocks\`